Databases:
Building a database using Access
How to Use This Course Book

This handbook accompanies the taught session for the course. Each section contains a brief overview of a topic for your reference and then one or more exercises.

The Exercises

Exercises are arranged as follows:

- A title and brief overview of the tasks to be carried out
- A numbered set of tasks, together with a brief description of each
- A numbered set of detailed steps that will achieve each task

Your lecturer will direct you to the location of files that are needed for the exercises. If you have any problems with the text or the exercises, please ask the lecturer or one of the demonstrators for help.

This book includes plenty of exercise activities – more than can usually be completed during the hands-on sessions of the course. You should select some to try during the course, while the teacher and demonstrator(s) are around to guide you. Later, you may attend follow-up Course Clinics at IT Services, where you can continue work on the exercises, with some support from IT teachers. Other exercises are for you to try on your own, as a reminder or an extension of the work done during the course.

Writing Conventions

A number of conventions are used to help you to be clear about what you need to do in each step of a task.

- In general, the word press indicates you need to press a key on the keyboard. Click, choose or select refer to using the mouse and clicking on items on the screen (unless you have your own favourite way of operating screen features).
- Names of keys on the keyboard, for example the Enter (or Return) key, are shown like this ENTER.
- Multiple key names linked by a + (for example, CTRL+Z) indicate that the first key should be held down while the remaining keys are pressed; all keys can then be released together.
- Words and commands typed in by the user are shown like this.
- Labels and titles on the screen are shown like this.
- Drop-down menu options are indicated by the name of the options separated by a vertical bar, for example File|Print. In this example you need to select the option Print from the File menu. To do this, click with the mouse button on the File menu name; move the cursor to Print; when Print is highlighted, click the mouse button again.
- A button to be clicked will look like this.
- The names of software packages are identified like this, and the names of files to be used like this.
Software Used

Access 2013
Windows

Files Used

Favourites.accdb
SchoolOfMotoring.accdb

Revision Information

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Author</th>
<th>Changes made</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>July 2013</td>
<td>Pamela Stanworth</td>
<td>Created derived from TDAB</td>
</tr>
<tr>
<td>1.1</td>
<td>February 2014</td>
<td>Pamela Stanworth</td>
<td>Rearranged chapter 3</td>
</tr>
<tr>
<td>1.2</td>
<td>August 2014</td>
<td>Pamela Stanworth</td>
<td>New course title</td>
</tr>
<tr>
<td>2.0</td>
<td>August 2015</td>
<td>Pamela Stanworth</td>
<td>Revised for Access 2013</td>
</tr>
</tbody>
</table>

Copyright

Pamela Stanworth makes this document and the accompanying PowerPoint presentation available under a Creative Commons licence: Attribution-NonCommercial-ShareAlike CC BY-NC-SA. pamela.stanworth@it.ox.ac.uk

Screenshots in this document are copyright of Microsoft.

The Oxford University logo and crest and the IT Services logo are copyright of Oxford University and may only be used by Oxford University members in accordance with the University’s branding guidelines.
# Contents

How to Use This Course Book ............................................................... 2

1 Introduction .................................................................................. 1
   1.1 What You Should Already Know .................................................. 1
   1.2 What You Will Learn ................................................................... 1
   1.3 What Is Access? .......................................................................... 1
   1.4 Where Can I Get a Copy? ............................................................. 1
   1.5 Using Office 2013 ...................................................................... 2
   1.6 Using the Database Files for IT Learning Programme Exercises – Access 2013 ................................................................. 3

2 Designing a Simple Database (a Single Table)............................... 4
   2.1 Some Database Vocabulary for Access ........................................ 4
   2.2 Single or Multiple Tables? ........................................................... 4
   2.3 The Design Process .................................................................... 4

3 Single Table Design – Implementing In Access ............................... 5
   3.1 Creating a Database .................................................................... 5
      Exercise 1: Creating a new desktop database file .......................... 6
   3.2 A New Table .............................................................................. 6
   3.3 Defining Fields in Design View ................................................... 7
   3.4 Primary Key .............................................................................. 8
   3.5 Data Types ................................................................................ 8
      Exercise 2: Creating a table with fields ....................................... 9
   3.6 Using the Table ......................................................................... 9
   3.7 Saving Data Values in the Table? ............................................... 9
   3.8 Creating Further New Tables In Design View ............................ 9
      Exercise 3: Using the table to store data (optional revision) .......... 10

4 Managing Tables and Databases ................................................... 11
   4.1 Saving the Table Design .......................................................... 11
   4.2 Closing the Table ................................................................. 11
   4.3 Closing the Database File ........................................................ 11
   4.4 Opening a Database File .......................................................... 11
   4.5 Deleting a Table ................................................................. 11
   4.6 Opening a Table .................................................................... 11
      Exercise 4: A database file with tables .................................... 11
5 Working With Fields In Access .................................................. 12
  5.1 Adding a Field ........................................................................ 12
  5.2 Changing a Field .................................................................... 12
  Exercise 5: Creating fields ......................................................... 12
  5.3 Changing Field Properties .................................................... 12
  5.4Helping the Users to Input Data Accurately ............................... 14
  Exercise 6: Field properties ........................................................ 17
  5.5 Index (optional) ................................................................. 18
  5.6 Primary Key Field ............................................................... 18
  Exercise 7: More table properties ................................................ 18
6 A Multi-Table Database Using Access ........................................ 19
  6.1 Designing a Multi-Table Database ........................................... 19
  6.2 Creating the Database and the Tables ..................................... 19
  6.3 The Relationships Diagram .................................................. 19
  Exercise 8: The Relationships diagram ....................................... 19
  6.4 Creating a Relationship ....................................................... 20
  6.5 One-to-Many Relationship ................................................... 21
  6.6 A Many-To-Many Relationship ............................................. 21
  6.7 A One-To-One Relationship ................................................ 22
  Exercise 9: Creating relationships between tables ...................... 22
7 Working with Relationships in Access ........................................ 23
  7.1 Relationships in a Query ....................................................... 23
  7.2 Printing the Relationships Diagram ...................................... 23
  7.3 Deleting a Relationship ....................................................... 23
8 Using Forms to Work on a Database – A Preview ....................... 24
  8.1 Why Use Forms? ............................................................... 24
  8.2 Using Forms to Work on Related Data ................................... 24
  8.3 How to Create Usable Forms ............................................... 25
  8.4 Exercise 10: Working on data in related tables ....................... 25
9 What Next? ........................................................................... 26
  9.1 Downloadable Course Materials and More – the ITLP Portfolio... 26
  9.2 Database Concepts Course Which Precedes This ..................... 26
  9.3 Database Courses Which May Follow This ............................ 26
  9.4 Course Clinics .................................................................... 26
  9.5 IT Services Help Centre ....................................................... 26
Appendix 1: Viruses and Security Levels in Access ............... 27
  Why Worry About Viruses? .......................................................... 27
  Scanning for Viruses ................................................................. 27
  Access 2013 and Virus Security ................................................ 27
  Further Help with Security and Trust Center Settings ............ 31

Appendix 2: One to One Relationship ........................................... 32
  One to One Relationships in Access ........................................ 32
  Setting Up the Relationships ..................................................... 32
  Working With The Data ............................................................. 33

Appendix 3: Student Exercises ....................................................... 36
1 Introduction

Welcome to the course “Databases: Building a database using Access”.

This booklet accompanies the course delivered by the IT Learning Programme at Oxford University. Although the exercises are clearly explained so that you can work through them yourselves, you will find that it will help if you also attend the taught session where you can get advice from the teachers, demonstrators and even each other!

If at any time you are not clear about any aspect of the course, please make sure you ask your teacher or demonstrator for some help. If you are away from the class, you can get help by email from your teacher or from help@it.ox.ac.uk.

1.1 What You Should Already Know

This session is one of a series that cover the important aspects of building and managing a database, using Microsoft Access as an example.

We will assume that you have already attended the course “Databases: Concepts of database design” (or equivalent), and that you have already designed your tables, with fields, data types and the relationships between them.

The computer network in our teaching rooms may differ slightly from that which you are used to in your College or Department; if you are confused by the differences, ask for help from the teacher or demonstrators.

1.2 What You Will Learn

In this session we will cover the following topics:

- Creating a database with tables and fields in Access
- Setting properties for the fields
- Understanding a database with multiple tables
- Understanding and implementing relationships in Access

Related Database courses, should you be interested, are given in part 9.3.

1.3 What Is Access?

Access is database management software. It enables you to build and maintain a database.

Access is part of the Microsoft Office for Windows package. Access is not available for Mac (Mac users may try FileMaker Pro).

An Access database consists of the data held in a number of tables, plus a number of other objects which are used to manage the data. All these are saved together in a single file. In this course, we will deal with tables, and we will mention forms, queries and reports.

1.4 Where Can I Get a Copy?

If you have a copy of Microsoft Office Professional, then you already have a copy of Access. If you are unable to find it on your computer, it may not have been installed and you should talk to your IT support contact (or the IT Services Help Desk).
If you are a member of staff, you can obtain a copy of *Microsoft Office Professional* from the Online Shop. Students can occasionally obtain *Microsoft Office* at a reduced cost: read more at the IT Services website.

### 1.5 Using Office 2013

If you have previously used another version of *Office*, you may find *Office 2013* looks rather unfamiliar. “Office 2010: What’s New” is a self-study guide covering the ribbon, Quick Access Toolbar and so on. This can be downloaded from the ITLP Portfolio at [http://portfolio.it.ox.ac.uk](http://portfolio.it.ox.ac.uk) (look in the *Access* category).

For anyone who prefers not to use a mouse to control software, or who finds a keyboard method more convenient, it is possible to control *Office 2013* applications without using a mouse. Pressing ALT once displays a black box with a letter or character next to each visible item on the ribbon and title bar (shown in Figure 1).

![Figure 1 Keystrokes to Control Ribbon Tabs and Title Bar (Press ALT to show these)](image)

After you have typed one of the letters/characters shown, the relevant ribbon tab or detail appears, with further letters/characters for operating the buttons and controls (shown in Figure 2).
The elements within a dialog can be controlled, as usual with Windows applications, by using TAB to navigate between items or by typing the underlined character shown beside an item.

1.6 Using the Database Files for IT Learning Programme Exercises - Access 2013

Note that Access 2013 only trusts files if they have been saved in a “Trusted Location”. The network drive H:, used for most IT Learning Programme courses, has been designated an Access Trusted Location in our teaching rooms. If you make copies of the files for these exercises, and save them on your own computer in a location that is not trusted, you may not be able to carry out all the activities described.

Appendix 1 discusses the question of virus protection and trusting locations further.
2 Designing a Simple Database (a Single Table)

2.1 Some Database Vocabulary for Access

A collection of database information is organised into one or more tables. You may think of each table in a grid layout.

Each row of the table is known as a record. There must be one record for each item included in the table – for example, the records may be about the employees in a department, the books in a library or the individual wall paintings in an ancient cave. The order of the records is not important: indeed it is usual to change frequently the order the records are shown in, when analysing the data.

No two records can be identical – there must be at least one different value to distinguish them.

Each column of the table is known as a field. Each field contains a different piece of information about the record items – for example, an employee’s date of birth, a book’s author or the dimensions of a painting. All the entries in one column must have the same data type e.g. all text or all integer numbers.

The set of tables, along with the queries, forms and reports used to manipulate them, are saved together in one Access file.

2.2 Single or Multiple Tables?

Initially, we will consider a simple situation where all fields are in one table – all the attributes describe one kind of item. The more realistic case of multiple tables is covered later (see Chapter 6 below).

2.3 The Design Process

When starting on a database project, it is important to plan carefully the structure of the database file and what items are to be included. These decisions about what fields are to be used, and how they are to be assembled into tables and related to one another, will critically affect the way you can analyse the results and interrogate the data later.

So in planning a database you would prepare a data model, which describes the project, items and types of information to be collected and the relationships between the entities. This must take account of any constraints from the real situation. It is difficult and time-consuming to re-construct a database that has been built in a way that does not properly model the real situation, once data has been entered.

This process is covered in the IT Learning Programme course “Databases: Concepts of database design” (details in part 9.2 below).

And finally the relationship design is implemented in software such as Access.
3 Single Table Design - Implementing In Access

3.1 Creating a Database

Once you have decided on the fields that are needed, and their data types, a new database file must be created using Access, and the fields must be defined in a table.

As Access starts, the backstage view gives options to create a new file. The simplest case is to choose Blank desktop database\(^1\). The filename and location for the database file must be specified at this point, navigating to a suitable device and folder and entering a filename.

\[\text{Figure 3 Creating a New Database File}\]

\(^1\) Access 2013 can also be used to create an app database: where users work on the data via a web browser. This would require communication using Office 365 or SharePoint 2013, and is not the subject of this course. We will create a desktop database, which is saved locally on your computer or a network drive.
Databases: Building a database using Access

Figure 4 Assigning a Filename and Location to a New Database File

Once the database file has been created, the whole of this database work will be
stored in this file: table(s), data, forms, queries and reports.

Figure 5 A New Table

The Navigation Pane is displayed at the left of the window. This will list any tables
in the database, as well as any forms, queries, reports and so on as they are
created.

Exercise 1: Creating a new desktop database file

Now look at this exercise (page 36).

3.2 A New Table

A new blank table is shown (Figure 5), awaiting your data. However, before you
start to enter data values, there are some design decisions to be made.

The new table has been provisionally named Table1. When it is first saved, you
assign a more interesting table name. Each table requires a name. By convention,
table names always begin with tbl.
Similarly, query names begin with **qry**, form names begin with **frm** and report names begin with **rpt**. These Reddick naming conventions can be found at [http://mvps.org/access/general/gen0012.htm](http://mvps.org/access/general/gen0012.htm)

Although it is possible in *Access* to include spaces in object names, it is good practice to avoid spaces. This is because when an object name is included in an expression (perhaps in a calculation), then any spaces are difficult for *Access* to parse and you must remember to enclose the object name in [square brackets] every time. Without any spaces, the names of tables, forms etc are not ambiguous and expressions are easier for *Access* (and people) to read. This also applies to the names of fields and controls.

Designers may use a mixture of lower case and capital letters and some punctuation symbols to make object names and field name easy to understand.

Examples might be **tblStudentApplication** or **qryLateReplies**, or **frmSimple_Address_List**.

### 3.3 Defining Fields in Design View

(On the **Home** tab of the ribbon) will switch to show the table in Design View. Design View shows a list of the field names that have been set up, each with its data type and its Field Properties. Here you add the names of the fields you require for this table.

![A Table in Design View](image)

As you click on any row, the Field Properties for that field are listed in the lower window pane. For example, the **Field Size** specifies the maximum number of characters or digits that the user will be allowed to enter. The **Caption** is the label that will appear with the field, on forms, reports etc. (this may differ from the field name itself, for instance including spaces and more familiar punctuation).

There is no theoretical limit on the number of fields per table, although *Access* allows a maximum of 255 fields per table. If you need more than 255 fields in a
3.4 Primary Key

One of the ready-made fields is set up to be the primary key (more on the importance of this in part 5.6 below).

In every table, one field must be nominated which has a unique value for every record – this will be used to identify the record unambiguously. This field (or, occasionally, combination of fields) is known as the primary key. This will become essential to the database design when there are two or more related tables.

3.5 Data Types

Each field is assigned a data type – this may be text, a number such as an integer or a fixed length decimal, date & time and so on. All the data in a particular field (for all the records) must have the same data type. If this is not possible, this is an indication that the fields have not been chosen correctly to represent the real situation.

Once data has been entered in a table, the data type cannot easily be changed, so the data types must be chosen carefully at the planning stage.

Data types available in Access are:

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Text</td>
<td>This may include words and digits which are not to be used as numbers for calculation</td>
</tr>
<tr>
<td>Long Text</td>
<td>Longer portions of text which will not be sorted or calculated (up to 65,535 characters)</td>
</tr>
<tr>
<td>Number</td>
<td>Numbers</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Dates and/or times</td>
</tr>
<tr>
<td>Currency</td>
<td>Numbers formatted for currency</td>
</tr>
<tr>
<td>AutoNumber</td>
<td>Assigns a fresh counting number as each new record is added (counting numbers can be sequential or randomly chosen)</td>
</tr>
<tr>
<td>Yes/No</td>
<td>Yes and no or a field that can only have one of two values (Yes is stored as -1, No as 0)</td>
</tr>
<tr>
<td>Attachment</td>
<td>Attach images², data, documents etc</td>
</tr>
<tr>
<td>Hyperlink</td>
<td>Address of a remote location, such as URL</td>
</tr>
<tr>
<td>OLE Object</td>
<td>A piece of data created in other software, such as an Excel spreadsheet or a graphic or photo, linked or embedded in the database</td>
</tr>
</tbody>
</table>

² Read about creating a field that contains images, and using it on a form, in an article in the ITLP Portfolio [http://portfolio.it.ox.ac.uk](http://portfolio.it.ox.ac.uk)
In Figure 7, the fields have been given a variety of data types. The **ContactID** field is used to identify each record uniquely, and it has the AutoNumber type; this means that as each new record is added, a new ContactID number will automatically be assigned to it. This is the behaviour needed for the primary key field of each table. The **LastName** field has the Short Text type. The **Remarks** field is Long Text type, allowing the user to enter a quantity of comments; such a field cannot be used for sorting or analysis.

### Exercise 2: Creating a table with fields

Now look at this exercise (page 37).

#### 3.6 Using the Table

From Table Design View, clicking ![View](image) will switch to Datasheet View. Here each field appears as a column, and any data values will appear in rows.

The first empty row is shown, ready for the first record to be entered. The mouse or arrow keys can be used to move between the fields of a record. Once some data has been entered in the first record (first row), you can move down and add another record.

The Close button ![Close](image) for closing just this table (leaving the database file open) is at the top right of the table window.

#### 3.7 Saving Data Values in the Table?

The data is saved automatically, without any confirmation from you, as you move from one record to the next, or as you close the table.

#### 3.8 Creating Further New Tables In Design View

In the Create tab of the ribbon, ![Create](image) will create a new blank table and display it in Design View. In Design View, you can add such fields as are needed (this is covered in part 5 below).
Exercise 3: Using the table to store data *(optional revision)*

Now look at this exercise (page 38).
4 Managing Tables and Databases

4.1 Saving the Table Design

Clicking on the Quick Access Toolbar or on the File menu will save the table design. If no name has yet been assigned to the table, you will be prompted for one.

Note that this does not save the data in a table: data is saved without confirmation when you move to another record.

4.2 Closing the Table

When some data has been entered, the table can be closed using . There is no command to save the data explicitly at this point, because new or amended data was saved as you moved between records.

You will only be prompted to save the table design if you have made any changes.

The table name now appears in the list of All Tables in the Navigation Pane.

4.3 Closing the Database File

The database file can be closed using on the File menu.

4.4 Opening a Database File

Selecting on the File menu gives you options for opening an existing database. Choose a recent file, or click then . From here you can navigate to the device and folder where a file has been saved. The file is opened in the usual Windows way e.g. select the filename in the dialog and click .

4.5 Deleting a Table

If a table is unwanted, right-click on its name in the Navigation Pane and select Delete. The table design and any data it contained are deleted.

4.6 Opening a Table

The bar at the top of the Navigation Pane is used to control the way that lists of the objects in the database file are displayed. All Access Objects is often a good choice here, as it lists all tables, forms, queries etc.

To open one table in Datasheet View, double-click the table name or right-click and select Open. To open the table in Design View, select Design View on the right-click context menu.

Exercise 4: A database file with tables

Now look at this exercise (page 40).
5 Working With Fields In Access

5.1 Adding a Field

Fields can be added to a new or existing table, in Design View.

![Figure 8 Adding New Fields to a Table](image)

In the first row, the first Field Name is typed. TAB or the arrow keys or mouse will move to the next column, where the data type is chosen from the drop-down list of types available. It is good practice to type a Description, which helps other users (and yourself in the future) to understand just what sort of information is expected in this field.

5.2 Changing a Field

The Field Name of an existing field can be changed by editing in Design View. Similarly the Description can easily be changed.

Although the data type can be changed, this may be difficult. Once data has been set up in the table, Access may prevent you changing the data type, if the existing data does not match the new type. It is important to choose the data types carefully at the planning stage, to avoid this difficulty if possible.

Exercise 5: Creating fields

Now look at this exercise (page 40).

5.3 Changing Field Properties

Field properties can be changed separately for each field, in Design View. While a field is selected in the upper window pane, its Field Properties are listed in the lower window pane. Some properties are assigned by default. Change a property by choosing from a drop-down list or by over-typing the previous value. Data types were discussed in part 3.5 above.

Note that if you change the data type or certain Field Properties, then any existing data in the table may or may not conform to the new settings. Access offers to check through the data – you should normally accept when this message appears. If any of the data does not conform to the new settings, you will have to edit it directly.
5.3.1 Number Format

The **Number** format controls the way a number will be displayed e.g. how many decimal places, with percent or currency symbol. This can be changed in the Properties of the field, where a drop-down list offers a choice of popular formats.

![Figure 9 Setting the Number Format for a Field](image)

5.3.2 Date Format

Dates can be entered and displayed in different standard formats. Once a field has been defined as the Date/Time type, the date **Format** can be set in the Field Properties.

If a field has been defined with the Date/Time type, then when someone uses that field (e.g. clicks on the field in Datasheet View or in a form), a date picker calendar is automatically displayed. This is often a convenient tool for entering a date. If this is not suitable, change the **Show Date Picker** property to **Never** for that field.
5.3.3 Field Size

Although the field size can be changed, this can lead to problems if it is attempted late in the life of a project. If existing data is longer than the proposed new data length, then when the data length is changed Access will truncate the data to fit. It is important to choose the field sizes carefully at the planning stage, before entering data, to avoid this difficulty if possible.

5.4 Helping the Users to Input Data Accurately

Some Field Properties can be set to help the users when inputting data. If there are rules or constraints on what values are permitted or are possible, these “business rules” can be incorporated in the Field Properties to prevent the user entering invalid data.

Note that these settings may help, but cannot prevent the user entering wrong data – that responsibility lies with the person working on the data.

5.4.1 Lookup

A lookup offers the user a limited list of permissible values to choose from, in a drop-down list.

This is set up for a given field using the Lookup Wizard (the command is found lurking at the bottom of the list of data types).

The simplest lookup is one where you type in a few values which you want to appear on the list.
The Lookup Wizard offers the Limit to List option. With this set, the user must choose one of the values offered in the lookup list. With this option cleared, the user may type an alternative value if none of those offered is suitable.

**Aside:** The Lookup Wizard also offers the Allow Multiple Values option. If you are tempted to use this option, you should instead review the design of your database and consider including a further table or tables, with one-to-many relationships to the present table. Chapter 6 below covers designing a database with multiple tables.

When the user is entering data (e.g. using a form or in Datasheet View), the lookup list appears and they can use the mouse to choose from the values offered. This avoids the problem of a popular data value which has to be typed or possibly mistyped into several records.

**Figure 11 Populating the Lookup List**

A lookup can be edited further in Table Design View, by changing the Properties on the Lookup tab of the Field Properties.

**Figure 12 Using a Lookup List in Datasheet View**
5.4.2 Validation Rule

The allowed values for a particular field may be constrained by the nature of the data (e.g. date of birth not before 1880) or by “business rules” which come from your own knowledge of the project (e.g. only University Members can book on a certain course).

This sort of constraint can be set up in the table design as a validation rule. The validation rule is typed in the Field Properties for the relevant field, as an expression using operators such as < > or =. When the user enters data in this field, Access will apply the rule as a test.

If the user tries to enter a value which does not satisfy the rule, they will see a message suggesting what is expected. This validation text should therefore be a helpful message explaining what data is acceptable.
5.4.3 Input Mask (optional)

An input mask is a pattern which controls the way the data will look, for example in text or date/time fields. The Input Mask Wizard offers some standard data patterns which can be applied to a field.

The wizard is started by clicking in the Input Mask field then clicking .

Figure 15 Choosing a Standard Input Mask

The input mask can be edited further, in the Field Properties pane. For example, the US-style mask provided for Postal Code (shown in Figure 15) is LL00 0LL. This mask expects two letters followed by two numbers in the first part, as in OX23. In the input mask, the 0 symbol represents a digit 0 to 9, entry required. An alternative is to use a 9 symbol, which represents a digit 0 to 9, entry optional.

If you want the users to be able to enter post codes starting with “two letters then one or two numbers”, then one of the 0 symbols must be replaced by a 9 symbol. Make this change in the input mask and then users will have the option of entering single-number postcodes such as OX2 6NN.

5.4.4 Default Value

The default value for a field is a value that will be entered unless the user specifies something else. This might be the start date of the project, or Mr in the Title field for people records.

The default value can be edited by overtyping in the Field Properties pane.

5.4.5 Mandatory Field

Setting the Required property to Yes means that the record edit or add process cannot be completed until a permitted value has been entered for this field.

Exercise 6: Field properties

Now look at this exercise (page 41).
5.5 Index (optional)

*Access* can create and maintain an index on a field. This means it keeps account of the order of the values held for each record. If a field has an index, this speeds up sorting and calculations on that field. However, there is a small penalty in the speed of updating the database (e.g. when a new record is added or a value is edited) because *Access* also updates all the relevant indices. This penalty may not be noticeable with a small database, however it is good practice not to set up an unnecessary index.

In the Properties for a field, the Indexed property can be changed from No to Yes. **Duplicates OK** allows two or more records to have the same value for this field (as for example with surnames). **No Duplicates** prevents a record being given a value that already exists for another record on this field (for example, this may be suitable for National Insurance numbers).

![Figure 16 Setting an Index on a Field](image)

5.6 Primary Key Field

On saving a table design, you may be prompted to nominate the primary key. This is a field (or combination) which uniquely defines the record – no other record can have this value for this field. *Access* will use the primary key to specify which record it is working on.

A new table may already have a primary key set up. The generic field name **ID** could be edited to something more specific to the table contents, such as **RoomID** or **EventID**.

The AutoNumber data type is usually a good choice for the primary key field: this means that *Access* will assign a unique number to each new record, automatically. This data type is likely to have been set up automatically for the **ID** field.

The primary key can be specified by selecting the field in Design View, then clicking **. A key symbol then appears beside that field.

Because the primary key is the field that *Access* uses for sorting, ordering and matching records, an index is automatically built on the primary key field.

Exercise 7: More table properties

Now look at this exercise (page 43).
6 A Multi-Table Database Using Access

6.1 Designing a Multi-Table Database

A very simple list of data may usefully be managed as a single Access table, however in other situations this may not model the real behaviour accurately, so the number of tables is an important decision.

A better design is to hold information about each kind of thing in separate tables, making cross-references between them. The various tables are all contained in one Access file. This is known as a relational model.

The reason for this is so as to represent the way the data behaves in the real world situation. A relationship (or join) is set up between two tables, so that each record in one table is related to one or more records in the other table.

This part of the planning must be done carefully, long before the database is set up in Access. It can be very difficult and time-consuming to re-structure into different fields or different tables once the data has been entered.

The fields must be chosen (as discussed in part 2.3 above) and assigned to a number of related tables. The paper-and-pencil exercise involves thinking about the purpose of the database, which data needs to be recorded and which questions will be asked at the analysis stage.

It is usually useful to present the tables and their field names as a diagram. This could be a pencil-and-paper sketch, showing all the tables and listing the fields for each table.

The course “Databases: Concepts of database design” covers how to design a multi-table database (see part 9.2 below).

6.2 Creating the Database and the Tables

Once the design is decided, and you know which tables will be needed, comprising which fields, it is time to set up the model using Access. It is important not to rush into building the Access model until the design has been properly thought through, as it can be difficult to revise a database once it has data in it.

Where a number of related tables are required to model a project, the tables can each be created separately in Access, as described in parts 3.1 and 3.8 above. Fields can be added to each table as described in part 5.1.

6.3 The Relationships Diagram

The Access Relationships diagram can be shown by clicking on the Database Tools tab. This diagram will show the joins between the tables.

In the Show Table dialog, you choose each table name in turn and click Add. A box for each table appears in the diagram, listing the fields, and these boxes can be rearranged by dragging the title bar or resized by dragging a border.

Exercise 8: The Relationships diagram

Now look at this exercise (page 45).
6.4 Creating a Relationship

You should already have decided which fields are to be used to make joins between the tables, so refer now to your hand-drawn diagram.

The most direct way to create joins is by dragging in the Relationships diagram. Starting by pointing to the name of a field that is to join, you can drag onto the corresponding field in another table. The direction of dragging is not important. After this dragging action, the Edit Relationships dialog appears.

![Edit Relationships dialog](image)

Figure 17 Creating a join by dragging in the Relationships Diagram

As illustrated in Figure 17, the two fields being joined need not have the same field name, although it is often convenient to have them so. The field at one end of the join is a primary key and the field at the other end is not.

This is a good point to confirm that Access has correctly interpreted the relationship type (reported at the bottom of the dialog). One-to-Many is the most usual type, but if you think Access has misinterpreted your intentions, it is wise to cancel the dialog and try again.

6.4.1 Referential Integrity

In the dialog, while setting up a join, you are asked about enforcing referential integrity.

It is usual to Enforce Referential Integrity.

This means your database insists that every foreign key value must find a matching primary key value in the connected table. For example, if referential integrity were enforced in a school classroom scenario, it would not be possible to assign a student to a class until a record had been created for that class.

With referential integrity enforced, if a user tries to create a record in one table, when no corresponding record exists in the related table, a message box will tell them they cannot proceed. They need to work on the related table first, creating a suitable record there, then come back to the present table to create the new record.

If in doubt, you should usually tick the checkbox to Enforce Referential Integrity and choose not to cascade update or delete.
Aside: Do not be tempted by the **Allow Multiple Values** checkbox which appears in some variants of this dialog - if you think you need to enter multiple values for a single field, you should review your database design carefully and consider adding another one-to-many relationship.

Referential Integrity is sometimes called Data Integrity.

### 6.4.2 Reviewing the Final Relationships Diagram

Every join (relationship) must be set up separately in this way, which may mean dragging and dropping between several tables.

Suitable relationships are set up between the tables.

Once the joins have been set up, they appear automatically as lines in the **Relationships diagram**. Access will use these relationships in future when queries are created.

1 and ∞ symbols appear at the ends of each join line, to show the “one” and “many” parts of the relationship.

![Relationships Diagram](image)

**Figure 18 Relationships Appear When Lookups are Created**

### 6.5 One-to-Many Relationship

This is the most common type of relationship: one record in a given table relates to several records in the other table. This appears in the Relationships diagram with a 1 symbol at one end and ∞ at the “many” end of the join line.

### 6.6 A Many-To-Many Relationship

This arises when many items in one table relate to many items in a second table. For example, in reporting how a group of students performed in a set of exams, there are many students doing many exams.

In practice, this is modelled by using a pair of one-to-many relationships with a “mixing” table between. The joins may be created using the same method as
described above. In our example this would be a table with one record per exam result. Then there are two one-to-many relationships: each student receives several exam results, and each exam paper was sat by several candidates.

Figure 19 Many-to-Many Relationship Between Students and their Subjects Examined

6.7 A One-To-One Relationship

The procedure for setting up and using a one-to-one relationship is described in Appendix 2.

Exercise 9: Creating relationships between tables

Now look at this exercise (page 46).
7 Working with Relationships in Access

7.1 Relationships in a Query

When a new query is created, if it includes two or more tables then Access uses any existing join that has already been defined in the Relationships diagram. This will be shown as a joining line in Query Design View. So it is usually convenient to define all relationships in the Relationships diagram, early in the design process when the tables are defined.

It is occasionally appropriate to define an additional relationship only in one query. This is done by working in Query Design View and dragging a join line between the two corresponding field names.

7.2 Printing the Relationships Diagram

This diagram is a very useful summary of how your database works. It is well worth printing a copy of the finished diagram, to refer to while you continue work. Relationship Report appears on the Relationship Tools Design tab when the Relationships window is showing.

7.3 Deleting a Relationship

If a relationship is defined in the Relationships diagram, then it can be deleted there. The join line can be selected by clicking it once, then deleted by pressing DELETE.

Once a join has been set up between fields in two tables, neither field can be deleted without first deleting the join in the Relationships diagram.

Beware that if the relationship is also shown in one or more saved queries, then deleting it from the Relationships diagram does not delete the join from individual queries. However, if you are making major changes to the structure of a database, going as far as editing the relationships between tables, you should perhaps consider deleting any existing queries anyway, and re-building them in the light of the revised model.

A relationship that is shown in a query must be deleted in that query: open the query in Query Design View, select the join line and press DELETE.
8 Using Forms to Work on a Database - A Preview

A later course will deal with the creation of a user-friendly collection of forms, for working on the data. Here we give a preview of why that is a useful approach to managing your database data safely.

8.1 Why Use Forms?

Once all the tables have been built, and the relationships between them have been set up, it is time to enter some data.

It is good practice to enter and edit data via a form, rather than by typing directly into the table. This is because a form can be designed for people to enter their data easily and efficiently, so as to minimise the chance of mistakes and transcription errors. Many forms have features which help the user to give correct rather than incorrect values, such as checkboxes, drop-down combo boxes and option buttons.

Any join data is easy to enter by this method, because a combo box (drop-down list box) offers the available values, usually as recognisable text. The user simply chooses the correct name, which is much easier than looking up serial numbers.

If just one record is shown at a time, as is common with forms, the user is less likely to type data into the wrong record.

![Figure 20 Working on Data Using a Simple Form](image)

8.2 Using Forms to Work on Related Data

Once relationships have been set up between tables, it becomes clear that a table is not a suitable environment for people to work on data. The table is the place where data is stored, but a set of forms are needed to provide a practical user interface.

For example, the table in Figure 21 lists the scores that a group of students achieved in recent exams. Each record (row) shows the score that a particular student achieved in a single subject exam. This information is only comprehensible for human readers if they have some way of looking up the student names and the subject titles by number: a tedious and risky step.
Figure 21 Student Exam Results In A Table

By contrast, Figure 22 shows a form based on the same table (2 views of the form). One record is shown at a time, reducing the risk of mis-entry. The controls for the StudentID and SubjectID have been replaced by combo boxes, each one populated from the relevant table (based on the joins shown in the Relationships Diagram).

Figure 22 The Same Exam Data, Working in a Form

8.3 How to Create Usable Forms


8.4 Exercise 10: Working on data in related tables

Now look at this exercise (page 47).
9 What Next?

Now that you have some useful database skills you may want to develop them further. IT Learning Programme offers a range of resources for study and teaching.

9.1 Downloadable Course Materials and More - the ITLP Portfolio

These course materials are available through the ITLP Portfolio, at http://portfolio.it.ox.ac.uk.

Each course pack includes the course handbook in pdf form and a zip folder of the exercise files that you need to complete the exercises. Archive versions of the course book may also be useful if you use an earlier version of the software.

The ITLP Portfolio helps you find articles, videos, resources and web-links for further IT study. For some resources, you will be asked for your Oxford (SSO) username and password.

It may be possible for you to use the facilities at IT Services to work through the exercises in this booklet, or use any of the applications that are available. Contact us on courses@it.ox.ac.uk for details.

9.2 Database Concepts Course Which Precedes This

Databases: Concepts of database design

9.3 Database Courses Which May Follow This

Databases: User-friendly databases using Access
Databases: Reporting data using Access
Databases: Querying and analysing data using Access

Read about the content of these courses in the IT Learning Programme Catalogue at www.it.ox.ac.uk/itlp/courses/catalogue

9.4 Course Clinics

We encourage everyone to work at their own pace. This may mean that you don’t manage to finish all of the exercises for this session. If this is the case, and you would like to complete the exercises while someone is on hand to help you, come along to one of the Course Clinics that run during term time. More details and booking are available from www.it.ox.ac.uk/courses/.

9.5 IT Services Help Centre

The Help Centre is also a good place to get advice about any aspect of using computer software or hardware. For Help Centre opening times, visit www.it.ox.ac.uk/help/gettinghelp/ and follow links to the General Helpdesk, or contact them by email on help@it.ox.ac.uk.
Appendix 1: Viruses and Security Levels in *Access*

**Why Worry About Viruses?**

A *virus* is malicious code that may arrive from another computer, and copy itself onto your hard disk. Depending on the taste of the person who devised it, it may be just a joke, or it may destroy data or system files. Some viruses send themselves on to other people via your email setup.

A virus may infect your computer while you are connected to the internet, or it may arrive attached to an email or on a contaminated removable disk, and it may take the form of a *macro* in an *Access* database file. It is essential to make provision for your computer to be scanned frequently for any viruses which may have arrived.

**Scanning for Viruses**

**Virus Scanning Software**

You should install and use virus-checking software such as *Sophos* (supported by IT Services). Other popular virus-checkers include McAfee *VirusScan* and Norton *AntiVirus*. Contact the Online Shop or visit www.it.ox.ac.uk for more information about obtaining *Sophos* at no cost or low cost for University members.

A typical virus-checker scans your computer disks according to a preset schedule. For instance, it may be set to check the hard disk every time you start *Windows*, or twice a week, or to scan every document on opening. The program detects any viruses, then alerts you and gives the options of deleting the file, putting it in quarantine or perhaps fixing it.

**Keeping the List of Viruses Up-to-date**

A virus-checking program must be kept up-to-date. It is important to connect frequently to the virus-checking centre (this is typically done via their internet website). The virus list on your computer is then updated with all viruses known to date, with any antidotes.

**Access 2013** and Virus Security

*Access 2013* considers any database file (such as *accdb* or *mdb*) as a potential route for virus infection. It starts by disabling any automatic content, and then asks you to decide whether to enable it.

*This applies to content such as macros and some Control Wizards and ActiveX Controls.*

Information about the other levels of protection, and further options for the way *Access* handles macros, is given in *Access Help*.

**Security Warning Message**

When you open a database file using *Access 2013*, a Security Warning message may appear in a white/yellow bar near the top of the window.

---

3 *Access 2007 and 2010 handle viruses in a similar way to Access 2013*
If you do not expect to use any automatic features, you can safely ignore this message and continue work.

**Enabling Automatic Content For Just One Visit**

Enable Content on the Security Warning bar gives you the opportunity to enable any automatic content that may be present: only do this if you are sure that the database file comes from a safe source and does not contain any virus or other hostile code.

Note that the decision to Enable this content is effective for this session only. If the database is closed, then the decision will need to be repeated each time it is opened. This may be a convenient and cautious approach to take.

**Trusted Locations in Access 2013**

Some locations (folders, drives or devices) can be nominated as Trusted Locations: Access then considers any database files found there to be trusted, and their automatic content is permitted to run.

So you may find it convenient to nominate a folder or area on your computer or your network as being Trusted by Access. Then make sure that all your Access database files are saved there.

This decision may be reached in consultation with colleagues and other users of the database, and with your local IT support contact. Some departments have a policy about where computer files of different kinds should be saved.

For example, in our teaching rooms, the students’ files are provided for you on a drive known as H:\, and this has been set as a Trusted Location in the installed copies of Access. Computers at IT Services have Sophos virus protection software which is kept up-to-date. If you are in an IT teaching room, you can rely on Sophos to manage the virus scanning.

The program files for Access are placed in a Trusted Location, by default.

**When to Trust a Location for Access 2013**

You should only consider doing this if you do need to use automatic content such as macros, and if you have made very good arrangements to protect the computer from virus attack.

If you are using a University- or College-owned computer, take advice from your local IT Support Staff before making a location Trusted. Ensure that you have reputable virus scanning software installed, and that you keep its files of known viruses up-to-date (i.e. it checks at least weekly by connecting to the software...
provider and downloading the latest lists). Then confirm that the software is configured to scan every file as it is opened.

Only once this is in place can you rely on the virus scanning software to do the virus scanning, and use Access to manage your database files.

**Finding the Access Trust Center**

You may decide to set Access to Trust a folder or computer storage area. This is done in the Trust Center, which is among the Access Options (found on the File menu).

In the left-hand column of the Access Options dialog, choose the Trust Center category. This reveals the button on the right.

![The Trust Center With the Trust Center Settings Button](image)

*Figure 24 The Trust Center With the Trust Center Settings Button*
Databases: Building a database using Access

How to Trust a Specific Location with *Access 2013*

Figure 25 The List of Trusted Locations

**Trusted Locations** (found in the category list on the left) shows which locations have already been treated as trusted. Here you can **Add new location…** or **Modify…**. Beware that if you add a location to this list, you are no longer protected from active content saved in that location.

If the location where you plan to save your databases is on a network drive, check **Allow Trusted Locations on my network** in the same dialog. You should consult the IT support contact who is responsible for the network, before doing this.

You may also decide to trust subfolders within the chosen location – there is a check box for this in the **Trusted Location** dialog.

Figure 26 Trusting Subfolders in a Trusted Location
Once a folder has been Trusted, save all database .accdb files there.

**Sandbox Mode**

Note that these choices make Access run in a controlled and limited way, known as sandbox mode. In sandbox mode, Access will run a reasonable range of commands and functions. Occasionally, some macros created using older versions of Access may need to be re-written using revised commands which are now permitted.

In sandbox mode, some commands are disabled because they are deemed potentially unsafe, and could be used maliciously to damage your files or system. A user can only disable sandbox mode by changing keys in the Windows registry, which is not a task for the inexperienced to attempt (if you are not perfectly familiar with working in the Windows registry, don’t experiment: ask someone who has experience, as there is a risk of making the computer unusable).

**Further Help with Security and Trust Center Settings**

There is a range of further settings available through the Trust Center. Read more about this in Access’ Help.
Appendix 2: One to One Relationship

One to One Relationships in *Access*

It is sometimes necessary to set up a relationship between two tables, where each record in one table matches exactly one record in the other table, and vice versa. This is a one-to-one relationship.

For example, if a table needs more fields than *Access* permits (max 255 fields in one table), you might set up two tables with a one-to-one relationship between them.

**Setting Up the Relationships**

The key point is to ensure that the field which relates the two tables cannot have duplicate values in either table.

**Step 1. Create both tables, with fields to link**

Include a field in one table which will relate to the primary key in the other table (we will refer to these as the pair of linking fields):

![Figure 27 Tables Whose Fields Will Be Linked](image)

In this example, we will use the **Patient** field in the `tblResults` table to link with **PatientID** field in the `tblPatients` table. Each patient will have just one set of results.

**Step 2. Make the linking fields “no duplicates” in both tables**

In both tables, set the Index property of the linking field to be “Yes (No Duplicates)”.

In the table where the linking field is the primary key, it is probably set to “Yes (No Duplicates)” already, since a primary key is not allowed to have duplicate values and *Access* automatically makes this setting for all AutoNumber fields.

In the other table, you should set this property of the linking field.
Step 3. Build a relationship

This is discussed in part 6.4 of the course handbook.

In the Relationships diagram, drag the field name of the linking field from one table and drop it onto the corresponding field in the other table.

In the Edit Relationships dialog which appears, check **Enforce Referential Integrity** but do not check **Cascade** options. Confirm that Access has read this as a One-to-One type of relationship.

In the Relationships diagram, the join appears. Check that Access marks the join in the Relationships diagram with a 1 at each end:

Working With The Data

Step 4. Create a query to re-assemble data that belongs together

Although the data about a particular patient has been split between tables, when you analyse the data you will want to see a patient’s data assembled together.

Create a query with both tables, and pick some fields to display.
This presents the data associated with each patient, taken from both tables:

### Figure 30 A Query Joining the Two Tables

So although the data is located in two tables, it can be assembled together for viewing and analysis.

### Step 5. Create a form based on the query

You don’t want to work on the data in datasheet view.

Create a quick form by first selecting the query name then clicking:

### Figure 32 An Instant Form Showing Patient Data
Step 6. Use the form to work on data

Using the form, add a new record:

![Form](image1)

**Figure 33 Working on the Data Using the Form**

In this form, you can conveniently enter the name of a new patient, their address and the results of their tests - some of those fields will be stored in one table, some go into another, but you don’t need to think about that when you are working in the form.

![Form](image2)

**Figure 34 Data From Both Tables is Available in One Form**

Step 7. Confirm that the data has been entered

Look at the raw data in the two tables. You have created a new record in each table, and they are linked together because they concern the same person.

![Tables](image3)

**Figure 35 Related Data is Stored in 2 Tables**

From now on, once you are sure that the data arrives correctly in the two tables, you will want to use the single form whenever working on this data.
# Appendix 3: Student Exercises

## Exercise 1  Creating a new desktop database file

- *Start Access*
- *Create a new file*
- *Save the new database*
- *Look at the Navigation Pane*

> *All the files for these exercises have been provided for you on a network drive. Your area of the drive is called **drive H**: In the IT teaching rooms, this drive has been set up as an Access Trusted Location*

<table>
<thead>
<tr>
<th>Task 1</th>
<th>Step 1</th>
<th>Step 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Access from the <strong>Start</strong> menu</td>
<td>Start the computer if necessary</td>
<td>Click the Start button on the taskbar at the bottom of the screen</td>
</tr>
<tr>
<td></td>
<td></td>
<td>In the <strong>Start</strong> menu, explore the software available and look for the <strong>Microsoft Office</strong> folder</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Choose Access</td>
</tr>
<tr>
<td></td>
<td><strong>Step 3</strong></td>
<td>If you are prompted for any user information, just click on <strong>OK</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Step 4</strong></td>
<td>(On your office or home computer you might otherwise start the program using an Access icon or tile on the Desktop)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Task 2</th>
<th>Step 1</th>
<th>Step 2</th>
<th>Step 3</th>
<th>Step 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new blank desktop database, named <strong>My Music Collection.accdb</strong> and save it in <strong>drive H</strong>: (or in another place as directed by your teacher)</td>
<td>Click on <img src="create_icon.png" alt="Create icon" /> to create a new desktop database</td>
<td>Enter a new filename <strong>My Music Collection</strong></td>
<td>Beside the filename, click <img src="browse_icon.png" alt="Browse icon" /> and navigate to <strong>drive H</strong>: (or another place as directed by your teacher)</td>
<td>Click on <strong>OK</strong> and then click <img src="create_icon.png" alt="Create icon" /></td>
</tr>
</tbody>
</table>
### Task 1
Continue working in the file **My Music Collection.accdb** which you created in the previous exercise.

You are going to create a table, to catalogue your collection of music (CD’s, LP’s, MP3’s, cloud collection etc.)

### Task 2
Use the blank new table provided

| Step 1 | Ensure that the new file **My Music Collection.accdb** is still open (use **File|Open** if necessary to find and re-open it) |
|--------|--------------------------------------------------------------------------------------------------------------------------|
| Step 2 | A new blank table is waiting for your data. Initially, the table is shown in Datasheet View. |
| Step 3 | Some nameless fields are provided – do not be tempted to add any data at this stage. |

### Task 3
If, later, you need to create further new tables, use ![Table icon](image) on the **Create** tab

### Task 4
Save the new table as **tblRecordings**

<table>
<thead>
<tr>
<th>Step 1</th>
<th>It is good practice to save the table with a conventionally-chosen name, before adding much information.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Choose **File</td>
</tr>
</tbody>
</table>

### Task 5
Click the **View** button ![View button](image) on the **Home** tab, to switch to Design View.

---

**Exercise 2  Creating a table with fields**

- *Create a table*
- *It will need fields for cataloguing a music collection*
- *In Design View, specify some fields*
- *Save the table design*
### Task 6
In Design View, set up fields for **RecordingID**, **Title** and **Condition**

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Edit the name of the first field to be: <strong>RecordingID</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Type the name of the next field: <strong>Title</strong></td>
</tr>
<tr>
<td>Step 3</td>
<td>Type the name of the next field: <strong>Condition</strong></td>
</tr>
</tbody>
</table>

### Task 7
Complete the data types and descriptions for the fields

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Confirm that both new fields have the <strong>Text</strong> data type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Type a few words as Description for each field</td>
</tr>
</tbody>
</table>

### Task 8
Save the table design

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Click on the <strong>File</strong> tab, to save the table design</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Do not close the table yet</td>
</tr>
</tbody>
</table>

### Exercise 3  Using the table to store data (optional revision)
- **In Datasheet View**, add some data
- **Navigate between fields and between records**
- **Close the table and close the file**

### Task 1
Continue working in the table **tblRecordings** which you created in the previous exercise
You are going to add some data, describing your collection of music (CD’s, LP’s, MP3’s etc.)

### Task 2
Use the **View** button on the **Home** tab, to switch to Datasheet View

### Task 3
In Datasheet View, enter data for these recordings, then some more of your own choice:

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Notice that the field names that you have set up are now shown at the tops of the field columns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>In the first record (the top row), type <strong>Revolver</strong> in the <strong>Title</strong> field</td>
</tr>
<tr>
<td>Step 3</td>
<td>You will use the <strong>Condition</strong> field (column) to record the condition of each record, CD etc.</td>
</tr>
<tr>
<td></td>
<td>In the first record, in the <strong>Condition</strong> field, enter <strong>Fair</strong></td>
</tr>
<tr>
<td>Step 4</td>
<td>Allow <strong>Access</strong> to enter a <strong>RecordingID</strong> number automatically</td>
</tr>
</tbody>
</table>
### Step 5
Move down to the next record
Add data for these further recordings, then some others if you wish:

<table>
<thead>
<tr>
<th>Dark Side of the Moon</th>
<th>Good</th>
</tr>
</thead>
<tbody>
<tr>
<td>Super Trouper</td>
<td>As New</td>
</tr>
<tr>
<td>Bohemian Rhapsody</td>
<td>Much used</td>
</tr>
<tr>
<td>Marriage of Figaro</td>
<td>Good</td>
</tr>
</tbody>
</table>

### Task 4
Practice using the mouse and the navigation buttons to move between cells of the table, between fields and between records

### Step 1
Use the mouse to move between fields, on the same record
Use the mouse to move to another record

### Step 2
Use the arrow keys to move between fields and between records

### Step 3
Use TAB and SHIFT+TAB to move between the fields and records

### Task 5
Close the table and close the file

### Step 1
Click \[\text{Save}\] to save the table design
Notice that you do not explicitly save the data: data is saved as you leave each record

### Step 2
Click \[\text{X}\] at the top right corner of the table, to close the table

### Step 3
Look for the new table name, `tblRecordings`, in the Navigation Pane

### Step 4
Use \[\text{File}|\text{Close}\] to close the My Music Collection file
Leave Access open
Exercise 4  A database file with tables

- Open an existing database file
- View the list of tables
- Delete a table
- Open an existing table in Design View

Task 1
Open Favourites.accdb and look at the tables listed
This file will be in drive H: (or in another place as directed by your teacher)

Step 1
Choose File|Open
If necessary, navigate to the network drive H:
(or another place as directed by your teacher)

Step 2
Open Favourites.accdb
This database contains some of Tom’s favourite pieces of work

Step 3
Ensure that the Navigation Pane shows all the Access objects, grouped into Tables, Queries, Forms and so on.
If necessary:
- click the menu bar at the top of the Navigation Pane
- under Navigate To Category choose Object Type
- under Filter by Group choose All Access Objects
Notice the list of tables that have already been created in this database, such as tblFavouriteBooks and tblFavouriteFilms

Task 2
Delete tblFavouriteBooks

Step 1
Select tblFavouriteBooks and press DELETE to delete this table

Task 3
Open tblFavouriteFilms in Design View

Step 1
Right-click on tblFavouriteFilms and choose Design View to open this table in Design View

Task 4
Leave the table open for the next exercise

Exercise 5  Creating fields

- Add some fields to a table
- Set data types for each field
- Give Descriptions

Task 1
Continue work on tblFavouriteFilms

Step 1
Ensure that tblFavouriteFilms is open in Design View
This is in Favourites.accdb
## Task 2
Add a new field called **Director**, with a suitable data type and description

### Step 1
Click on an empty row in the table design grid
In the **Field Name** column, type **Director**

### Step 2
In the **Data Type** column, click the drop-down menu and choose **Short Text**

### Step 3
Type a Description:
Name of the film’s director

## Task 3
Add another field for the date that Tom (or his mum or whoever) first saw this film

### Step 1
Click on another empty row
In the **Field Name** column, type **DateSeen**

### Step 2
In the **Data Type** column, click the drop-down menu and choose **Date/Time**

### Step 3
In the **Description** column, type **Date you first saw this film**

## Task 4
Close the table, saving changes to the design when prompted

### Step 1
Click **×** on the table title bar
When prompted, agree to save changes to the table design

## Exercise 6  Field properties
- Set formats for some data fields
- Set up a lookup list for a field
- Create a validation rule and text for one field
- Make one field mandatory
- Try the new design in Datasheet View

## Task 1
Open **tblFavouriteMusicTracks**

### Step 1
Select **tblFavouriteMusicTracks** and open it in Design View
This is in **Favourites.accdb**
**Task 2**  
Change some data formats:  
| Field size for **Title** is 100 characters | **Step 1**  
| Title is a mandatory field | Click in the **Title** field row  
| DatePurchased has the format Medium Date | In the Field Properties, click in the **Field Size** row and enter 100  
| Price has the Currency data type |  

**Step 2**  
Still with the **Title** selected, click in the **Required** property and choose **Yes**  

**Step 3**  
At some point, Access offers to check that the data still conforms to the new data type you have set: agree to this when asked  

**Step 4**  
Click in the **DatePurchased** field row  
In the **Data Type** column, choose **Date/Time**  

**Step 5**  
In the Field Properties, click in the **Format** row and use the drop-down menu to choose **Medium Date**  

**Step 6**  
Click in the **Price** field row  
Select the **Currency** data type  

---  

**Task 3**  
Set up a lookup control to help users choose a person for **WhoseFavourite**  
(Do not limit users to the names offered in the list)  

**Step 1**  
Select the **WhoseFavourite** field  
The command to start the Lookup Wizard is found lurking at the bottom of the **Data Type** drop-down  
Start the Lookup Wizard  

**Step 2**  
You will type in the values (one in each row, in one column)  
Give some plausible names, such as Edward, William, Clarrie, Emma, Nic, Joe  

**Step 3**  
Accept the suggested name for the lookup control  

**Step 4**  
Leave the **Limit to List** checkbox clear, so that users can type another name if none of the suggested names is suitable  

---  

**Task 4**  
The **Rank** must be a number from 0 to 10, so set up a Validation rule and Validation text  

**Step 1**  
Select the **Rank** field  

**Step 2**  
In the Validation Rule property, type **between 1 and 10**  

**Step 3**  
In the Validation Text, type **Please rank this item from 1 (best) to 10 (worst)**
**Task 5**  
Save the design, then try out the changes in Datasheet View

**Step 1**  
Click  to save the table design changes  
Use the View button on the Home tab, to switch to Datasheet View

**Step 2**  
Start to add one more track, such as Clarrie’s 3rd favourite, by Art Garfunkel (she bought it on 6th August 1979 and paid £1.99)  
Notice the effect of the date picker and the lookup list control

**Step 3**  
Try to leave this record without entering a Title  
What happens? Why?  
Now give a title such as Bright Eyes

**Step 4**  
Try entering a Rank of 18, and test the effect of the Validation Rule

**Step 5**  
Add some more plausible records, for practice, if you like

**Task 6**  
Close the table

**Exercise 7  More table properties**  
- Create a new table in Design View  
- Give it some fields  
- Set an index  
- Set a primary key  
- Save the design and close the table

**Task 1**  
Create a new table where a musician can list the songs his band will play at a club, with the order they will be done

**Step 1**  
Continue working in Favourites.accdb  
On the Create tab, click on

**Task 2**  
Include fields such as SongID, SongTitle, RunningOrder

**Step 1**  
In Design View, edit the first field provided to be this:  
field name SongID  
data type AutoNumber  
description a counting number assigned automatically
### Step 2
Create some further fields:

<table>
<thead>
<tr>
<th>Field name</th>
<th>SongTitle</th>
<th>RunningOrder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data type</td>
<td>text</td>
<td>number</td>
</tr>
<tr>
<td>Description</td>
<td>Give the title of the song or track</td>
<td>When is it played (1 for first, 10 for last)</td>
</tr>
</tbody>
</table>

#### Task 3 (optional)
Assign an index to the RunningOrder field (do not allow duplicate values)

#### Task 4
Set the SongID field to be the primary key

#### Task 5
Close the table, saving the design

#### Task 6
Close Favourites.accdb, leaving Access open
**Exercise 8  The Relationships diagram**

- Set up a Relationships diagram with all the available tables
- Rearrange the field lists, move and stretch them

### Task 1
Open **SchoolOfMotoring.accdb**
This concerns a driving school, the instructors and students and the lessons they attend

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Find <strong>SchoolOfMotoring.accdb</strong> and open it</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>In the list of tables in the Navigation Pane, examine the names of the tables included</td>
</tr>
<tr>
<td>Step 3</td>
<td><strong>tblStudents</strong> lists the students with their contact information and brief notes on their progress through stages of learning to drive</td>
</tr>
<tr>
<td></td>
<td><strong>tblInstructors</strong> lists the instructors with a driving school, with their contact information</td>
</tr>
<tr>
<td></td>
<td><strong>tblLesson</strong> lists the driving lessons which take place, specifying which instructor and which student were present at each lesson</td>
</tr>
<tr>
<td></td>
<td><strong>tblLessonType</strong> is a short list of the types of lesson offered, with the cost of each</td>
</tr>
</tbody>
</table>

### Task 2
In the Relationships diagram, add all the tables Rearrange the table field lists, and examine the fields included in each

<table>
<thead>
<tr>
<th>Step 1</th>
<th>On the <strong>Database Tools</strong> tab, click on the Relationships tab to display the Relationships diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>If the Show Table dialog does not appear, click</td>
</tr>
<tr>
<td>Step 3</td>
<td>Add all the four tables</td>
</tr>
<tr>
<td></td>
<td>(If a table gets added twice, then after closing the <strong>Add</strong> dialog you will be able to select a table field list and press <strong>DELETE</strong> to remove the duplicate)</td>
</tr>
<tr>
<td>Step 4</td>
<td>Notice the fields that are included in each table</td>
</tr>
<tr>
<td></td>
<td>Drag the field lists to convenient positions on the diagram</td>
</tr>
<tr>
<td>Step 5</td>
<td>Drag the borders of field lists to stretch or shrink them until all the field names are visible in each</td>
</tr>
</tbody>
</table>

### Task 3
Close and save the Relationships diagram for now
<table>
<thead>
<tr>
<th>Exercise 9  Creating relationships between tables</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Set up a join between two tables, in the Relationships diagram</td>
</tr>
<tr>
<td>• Set up several more joins</td>
</tr>
<tr>
<td>• Enforce Referential Integrity for all joins</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Task 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Continue work in SchoolOfMotoring.accdb</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Task 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display the Relationships diagram</td>
</tr>
<tr>
<td>Confirm that the 4 tables are displayed (refer to the previous exercises if necessary)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Task 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Join the StudentID fields in the lessons table and the students table</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point to StudentID in tblLesson</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drag to StudentID in tblStudent and drop</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>The direction of dragging does not matter, but it is important that you point accurately to the correct field name</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Task 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>In the dialog that appears:</td>
</tr>
<tr>
<td>Confirm the table names and field names</td>
</tr>
<tr>
<td>Confirm that this is a One-to-Many relationship</td>
</tr>
<tr>
<td>Choose to Enforce Referential Integrity</td>
</tr>
<tr>
<td>Do not choose to Cascade Delete or Cascade Update</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Task 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Finish the wizard and save the diagram design so far</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Task 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Also build a join between the table of instructors and the table of lessons, using the InstructorID field</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Task 7</th>
</tr>
</thead>
<tbody>
<tr>
<td>Build a join between the table of lesson types and the table of lessons, using the LessonTypeID field</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Task 8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Review the Relationships diagram, and confirm that suitable joins have appeared between the tables</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Task 9</th>
</tr>
</thead>
<tbody>
<tr>
<td>Look carefully at the 1 and ∞ symbols that have appeared around the tables:</td>
</tr>
<tr>
<td>are they sensible?</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Task 10</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close the Relationships diagram</td>
</tr>
</tbody>
</table>
Exercise 10  Working on data in related tables

- Examine one student’s record
- Add a lesson for that student
- Notice that the lesson can now be found via the relevant student’s record or via the relevant instructor’s record
- This helps you understand how data in tables is related by joins
- Working directly on data in tables is risky and inefficient for humans
- This work is usually carried out using forms rather than directly in the tables

<table>
<thead>
<tr>
<th>Task 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Continue work in SchoolOfMotoring.accdb</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Task 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open tblStudent</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Task 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Examine the lessons that Steven Jenkins has taken</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>In record 2, Steven Jenkins’ record, click at the left end</td>
</tr>
<tr>
<td>This expands data that is held in another table, related to this record</td>
</tr>
<tr>
<td>Note that if no at the left end, you may need to set up joins between tables as described in earlier exercises</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notice that Steven Jenkins, who is student no. 2, had 2 lessons in 2000 with different instructors</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click to collapse the record again</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close the table of students</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Task 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add another lesson for Steven Jenkins in the table tblLesson</td>
</tr>
<tr>
<td>Give some plausible data</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open tblLesson</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>In the new record at the bottom, add this information about a driving lesson:</td>
</tr>
<tr>
<td>Student ID</td>
</tr>
<tr>
<td>InstructorID</td>
</tr>
<tr>
<td>Date</td>
</tr>
<tr>
<td>Start time</td>
</tr>
<tr>
<td>Length</td>
</tr>
<tr>
<td>Collect and drop off</td>
</tr>
<tr>
<td>Lesson type</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Task 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Examine the tables of students and instructors, to see the new Steven Jenkins lesson</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open tblStudent again</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expand Steven Jenkins’ record again, and notice the new lesson now appears there</td>
</tr>
</tbody>
</table>
Step 3
Open **tblInstructor** and notice the new lesson also appears there, in Andrew Smith’s record

<table>
<thead>
<tr>
<th>Task 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>When a new record is added to a table, it is automatically related to the relevant record in other tables – this uses the joins that you set up earlier</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Task 7</th>
</tr>
</thead>
<tbody>
<tr>
<td>In this exercise, you added data in a laborious manual way, so as to see how the relationships between tables work</td>
</tr>
<tr>
<td>In practice, of course, you would not work on the data directly in the tables</td>
</tr>
<tr>
<td>In later courses, you will learn to create forms where people can work more safely and efficiently on the data: for example, instead of requiring you to know the correct record number for each student and each instructor, a form offers a pick list or “combo box” where a human user can select the appropriate item from a text list</td>
</tr>
</tbody>
</table>
Databases: Building a database using Access TDAF

Today’s arrangements
Your teacher is:
Your demonstrators are:
We finish at: 12:15

Your safety and comfort are important
Where is the fire exit?
Please report any equipment faults to us
The toilets are along the corridor outside the teaching rooms
The rest area is where you registered; it has vending machines and a water cooler

The course handbook
Notes on each topic
Tasks for you to practice during today’s course
Work at your own pace!
Divided into tasks and small steps
Be selective
Follow-up work
Continue with exercises after the session
Course Clinics

Road map for “Building a database”
### Databases: Building a database using Access TDAF

#### Planning a Database Table

**Database vocabulary**

A **database** is a collection of data

Data is organised into one or more **tables**

Each row is a **record**

Each column is a **field**

<table>
<thead>
<tr>
<th>Name</th>
<th>Phone</th>
<th>Town</th>
</tr>
</thead>
<tbody>
<tr>
<td>Peter</td>
<td>238172</td>
<td>Oxford</td>
</tr>
<tr>
<td>Sheila</td>
<td>426372</td>
<td>Witney</td>
</tr>
<tr>
<td>Janine</td>
<td>826812</td>
<td>Thame</td>
</tr>
</tbody>
</table>

#### Decide on the fields

Think of all the facts that will be collected

- plenty of fields
- consult widely
- small fields “atomic”

#### Designing a table

Choose tables and fields that match the real situation:

<table>
<thead>
<tr>
<th>tblEvent</th>
<th>EventTitle</th>
<th>Date</th>
<th>TimeStart</th>
<th>TimeEnd</th>
<th>Venue</th>
<th>PersonOrganising</th>
<th>Sponsor</th>
<th>CateringRequired</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>text</td>
<td></td>
<td>date/time</td>
<td>date/time</td>
<td>text</td>
<td>text</td>
<td>text</td>
<td>yes/no</td>
</tr>
</tbody>
</table>

Choose all the fields that might be needed

Small facts, “atomic”

Difficult to add a field later

---

**Building a Single Table Database Using Access**

Choose a data type for each field:

- Text, Number, Date/time, Currency, Yes/No

Not always obvious.
Databases: Building a database using Access TDAF

Getting started with Access

Start Access
Use a desktop icon or Start menu

Access version 2013 in teaching rooms
Enabling active content?
(see appendix in the course book)

Create a new desktop database file

All tables, queries, forms, reports etc are saved in one database file MyDatabase.accdb
Today, please work in your network drive H:

Creating a Table

Create a new table

Blank table is offered
For further tables, use on the Create tab
Save the table
Table names begin with tbl
No spaces, limited punctuation in names

Two views of a table

Datasheet View
Table is laid out in rows and columns

Design View
Fields are listed, with their data types
Can edit the field names
Creating fields in Design View

Field name (no spaces)
Data type
Description

(Features: see later)

Datasheet View is for viewing raw data

Enter or correct the data
Navigate
Data is saved as you leave a record

Choose one field to be the primary key

A field where every record has a different value so it can identify the record uniquely

May create a dedicated field
  e.g. PersonID
  Use AutoNumber data type

Or nominate an existing field?
  e.g. EmployeeNumber
  Use on Design tab

Working With Fields and Properties

Properties for individual fields

Set properties to make each field more usable
  Field size, caption, format for dates and numbers
  Access cannot test whether the values are correct, only whether they are plausible
  Help the user to give accurate data

- Default Value
- Required Field
- Validation Rule
  and Validation Text
Databases: Building a database using Access TDAF

Make data entry easy - build a lookup

**A lookup offers a list of permitted values**
- Helps ensure consistent data entry

Lookup Wizard: it’s on the Data Types list
- Limit to List?

A word about input masks (optional)

**Mask sets a pattern which the user must follow**
- e.g. ABC-1234 for a product code

**Input mask is a property of the field**
- Choose from the list of input masks
- Or edit an existing input mask

Some fields need an index (optional)

**Index is a list of the order the records lie in, when sorted**
- Speeds up calculations and sorting
- May slow down data entry

**Set Indexed property of a field to Yes**

Databases: Building a database using Access

- Look at Exercises 1 to 7
  - Exercise 3 is optional revision

Drinks and food in the refreshment area only, please
- Restart at 10:30

Demonstrator:

If you want to continue with the Exercises, you could ...

- Copy the Exercise files to a memory stick
- Download the files (and more) from the ITLP Portfolio at http://portfolio.it.ox.ac.uk

Designing with MultipleTables
Databases: Building a database using Access TDAF

Designing a relational database

Plan it on paper first
Choose the tables, then the fields
Mark how the tables are related

Flat file design?

All data in one table - like a spreadsheet
But does this suit your real situation?

Clues in the data
Redundant data
Inconsistent data
Inflexible data, difficult to analyse

Multiple tables generally mean a better model

Relating two tables

Nominate a primary key in each table
Mark which field links this table to that table
Convenient to have same or similar field names

Relationship types

One-to-many (the most common)
One record in this table corresponds to several records in that table
Primary key is on the “one” side

One-to-one
Less common

Many-to-many
Modelled using two one-to-many joins, with an intermediate table to link them

Relationships In Access
Creating a multi-table database

One Access file contains several tables
Each table must have a primary key
Joins will show how they are related

Joins between tables

... Referential integrity ...

Prevent orphan records
Meaning “Every foreign key value must find a matching primary key value”
Access can enforce referential integrity on a join

The complete Relationships Diagram

Easiest for people to work on data using forms

Too risky to work on data in tables
A form is safe and efficient for humans
Usually one record at a time
Easy to use
Related data appears via drop-downs

Coming later
More About Access

Databases: Building a database using Access TDAF

Further courses

Databases: Concepts of database design

Next steps with Access:
- Databases: User-friendly databases
- Databases: Reporting data
- Databases: Querying and analysing data

If you want to continue with the Exercises, you could...

Copy the Exercise files to a memory stick
Download the files (and more) from the ITLP Portfolio at http://portfolio.it.ox.ac.uk
Come along to Course Clinics (iT teachers will be there to help)

Databases: Building a database using Access

Now look at the remaining Exercises from 8 onwards
Then ... “BYO: Bring Your Own Project”:
- Think about your own project: what can you design?
- If you have brought your own design for a database, talk to our teachers about it
- For more ideas, look in Portfolio for the “Database Concepts” course pack

Finish at 12:15

This presentation is made available by Pamela Stanworth under a Creative Commons licence:
Attribution-NonCommercial-NoDerivs
CC BY-NC-ND
pamela.stanworth@it.ox.ac.uk